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Mimio Webinar Series | Getting More from Your Lessons with Mimio, March 26, 2015 

Presenter: Lindy George, Claire Pavia 

Recording Link:  

https://mimio.adobeconnect.com/p9qz00bvlla/ 

 
Questions and Answers: 

Q: Could I use a mix of Android and Apple devices, and could they be used at the same time? 

A: Yes, you can use any combination of Android and Apple devices at the same time. The 

MimioMobile™ app supports iPad 2, iPad 3, iPad 4, iPad mini devices, iPhone (4th generation and 

higher), iPod Touch (4th generation and higher), and Android 3.0 (Honeycomb) tablets and smartphones. 

You can learn all about using the MimioMobile app in your classroom in our free MimioTraining™ Quick 

Learn session, Mimio Goes Mobile: http://www.mimio.com/en-NA/Training/QuickLearn-Overview.aspx 

 
Q: Can I install the MimioMobile app on my smartphone and on iPad tablets? 
A: Yes. With the MimioMobile app, you can use any combination of Android and Apple phones and 
tablets at the same time. The MimioMobile app supports iPad 2, iPad 3, iPad 4, iPad mini devices, 
iPhone (4th generation and higher), iPod Touch (4th generation and higher), and Android 3.0 
(Honeycomb) tablets and smartphones.  

Q: How do I use a QR code to connect the mobile devices used in my classroom to the MimioMobile 
app? 
A: Download our step by step MimioMobile Connecting Guide to learn how simple it is to connect the 
teacher and student devices using the MimioMobile app. More helpful resources can be found at 
http://www.mimio.com/en-NA/Training/Overview.aspx. With the latest version of MimioStudio and 
MimioMobile, you can connect up to 50 mobile devices to take part in collaborative lessons and 
assessments. 

Q: How do I use the MimioMobile app? 
A: Using the MimioMobile app, students can interact individually with a lesson at the front of the room 
display when a teacher passes them control using the Control feature. This can be used with any student 
one at a time that has a MimioMobile enabled device. Using the Collaborate feature, the teacher can 
push out a complete interactive lesson page and give up to 50 students with mobile devices the ability 
to collaborate simultaneously using a limited tool set that includes a selection, pen, highlighter, 
undo/redo and eraser. Similarly, using the Quick Collaborate function, the teacher can enable a blank 
whiteboard screen for up to 50 student devices creating endless options for instruction and activities. 
Students can use MimioMobile enabled mobile devices to take assessments that include standard 
multiple choice, true-false, and open response questions that require essay, short answer and numeric 
responses. A perfect addition to help students practice for the Common Core assessments. See more 
examples in our “Collaboration to the Core” sample lessons that can be found at 
http://mimioconnect.com/collaborate. Learn all about using the MimioMobile app in the classroom with 
our MimioTraining Quick Learn session, “Mimio Goes Mobile”. 

Q: Where is the MimioStudio™ Recorder found?  
A: You can find this tool by clicking on the Applications button found on the Mimio floating toolbar. 

https://mimio.adobeconnect.com/p9qz00bvlla/
http://www.mimio.com/en-NA/Training/QuickLearn-Overview.aspx
http://www.mimio.com/~/media/Files/Downloads/Support/Documentation/MimioMobile/MimioMobileConnecting_MS11.ashx
http://www.mimio.com/en-NA/Training/Overview.aspx
http://mimioconnect.com/collaborate
http://mimio.com/QuickLearn
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Q: You mentioned a Class Manager, how do we get that from MimioStudio? 
A: The Class Manager is found by clicking on the Applications button on the Mimio floating toolbar.    
You would also need to have set up your students in classes within the MimioStudio Gradebook before 
you could use the Class Manager to allow student mobile devices to connect. However, you could also 
use the Anonymous class without any setup. Using this option you wouldn’t be able to collect any 
specific data from students. 

The MimioStudio Gradebook is installed when you install the MimioStudio software. If you are using the 
MimioVote™ assessment and/or the MimioMobile app and want to collect data, you should use the 
MimioStudio Gradebook. You would initially set up the MimioStudio Gradebook with the roster of all 
students in a class. Each student is assigned a specific entry, so no matter what type of device they use – 
whether it is a MimioVote unit or MimioMobile-enabled mobile device – all data is collected properly. 
The software is designed to give classroom teachers flexibility in what technology they use in their 
classroom. Additionally, you can simply use the MimioStudio Gradebook as a stand-alone gradebook 
application if you need it for your classroom. Learn more about setting up the MimioStudio Gradebook 
in our Quick Learn session, MimioStudio Gradebook: Setup and Reports.  
 
Q: I’m having a hard time seeing how I could use the feature of connecting up to three mobile devices 
using the MimioMobile app, free with any MimioStudio license in a classroom of 30 kids. What 
suggestions do you have?  
A: The great part is it gives the opportunity to try the MimioMobile app before buying it for your entire 
classroom. You can simply pass the MimioMobile enabled devices around to different students in a 
round-robin style, to have them all take part in the lesson activities. Using the MimioMobile app, you 
can push out a lesson page to student devices for collaboration to take place. Students can then 
complete the activity on the page. Students that don’t have a mobile device can see what is taking place 
by watching the front of the room board where all the activities will be shows. This allows the teacher to 
observe what students are doing collectively in real time. You could even group your class into groups 
based upon the number of mobile devices you have. Then, have the students within the group pass the 
device around to complete individual objectives or activities. Just make sure you have the latest version 
of MimioStudio software installed on your teacher computer. If you decide that you want to enable 
more students to use the MimioMobile app, you will need to purchase a MimioMobile license. 
 
Q: What is the cost for the MimioMobile app? Are there educator discounts? 
A: An annual classroom license, which allows all mobile devices to connect to the teacher computer, is 
$199. A school site license is $2699. It is an annual license and it will expire after one year, once it’s 
activated. If the license isn’t renewed, it will revert back to the lite version, allowing you to use it with up 

to three mobile devices in your classroom at no cost. You can purchase the license and find out about 

volume licensing costs through your Mimio salesperson or your local reseller. To find the reseller or 
Mimio sales rep nearest you, visit http://www.mimio.com/en-NA/Purchase/Resellers.aspx.  
 
Q: Will Mimio lessons work on a Chromebook, Windows, or Kindle? 
A: Currently, MimioStudio software is available for Windows, Mac, and Linux. Although the ability to 
install the software on other platforms such as Chromebook and Windows tablets is not currently 
available, it is part of our product plan for late 2015. 
 

http://www.mimio.com/en-NA/Training/QuickLearn-Overview.aspx
http://www.mimio.com/en-NA/Purchase/Resellers.aspx
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Q: I’m looking for ways to differentiate math using the MimioMobile app. What ideas do you have? 
A: Using the MimioMobile app, your options are limitless. Depending on your instructional goals, you 
can do a variety of things to differentiate the instruction. You could have a lesson page with various 
activities on it. As you push this lesson page out to student mobile devices using the Collaborate mode, 
different students could work on different activities. Even more powerful, you can use the Quick 
Collaborate feature. You’ll find this in the Applications button on the Mimio floating toolbar. This creates 
a blank page on each mobile device. You can then have your students work out any math problem 
whether it’s from a textbook, worksheet, or one that you provide. The power of this tool is the blank 
page with access to a limited set of tools (pen, highlighter, eraser, undo/redo) that allows students to 
write, demonstrate, and model the skills. You can then pick and choose what students do as well as 
focus in on groups or students or individual students. You don’t have to have an already designed lesson 
to make differentiation a possibility. Make whatever you do fit the needs of your classroom and 
students. Additionally, you can use the built-in features of MimioMobile during collaboration to pause 
all student devices or even hide what everyone can see on the front of room display. Learn all about 
using MimioMobile in your classroom with our Quick Learn training session, “Mimio Goes Mobile”. 

Q: How did you design the checkmarks to reveal the answers? 
A: This particular checkmark reveal, as with most items like this, is a combination of items. For the check 
mark reveal demonstrated, you first must add your desired instructional elements either from the 
MimioStudio Gallery or any other resource. Once you create your object you want to click to reveal, you 
would then animate it. Do this by right-clicking and choose Animate, or Insert > Animate. You will then 
be able to select from a list of animations. If you want it to slide in as demonstrated, you’ll select one of 
the “slide in from...” options. You can also then select one of the Triggers at the bottom. “Triggers” 
refers to the icon that will be attached to the text box that you’ll click on. The three Triggers are Default 
(grey triangle icon), Results (graph icon), and Notes (question mark icon). We typically use the Notes 
option for objective boxes. Click OK to set it. If you click on the icon that was created, the object you 
animated will move into the position where you set it. You’ll notice a blue border around the object. 
This indicates that it’s an interactive element of your page, and you’ll want to lock it to make the blue 
border go away. Select your newly animated object, right-click, and choose Lock or Format > Locking > 
Lock. 

Learn more about the Animate tool in our Quick Learn session MimioStudio: Formatting II. 
http://mimio.com/QuickLearn 

Q: Is Mimio geared toward a certain grade level? 
A: The use of MimioClassroom products is an ideal solution for any grade level or subject area. The 
nature of the interactive technology lends itself to the easy integration into what you normally do in 
your classroom – Teach! Not only is it easy to learn how to get started, we support you all way with our 
various training materials and the teacher community, MimioConnect. MimioConnect is full of ready-to-
use lessons or easily able to be modified to fit your needs. 

Q: How many teachers can use a license for the MimioMobile app? 
A: When you install MimioStudio software on your teacher computer and it’s activated by connecting 
any Mimio product, you can use the MimioMobile app with any mobile device in your classroom that 
connects with that one teacher computer. The license is per computer on which MimioStudio software 
is installed. If every teacher has MimioStudio software installed on his or her computer and uses a 
Mimio product, they all can make immediate use of the MimioMobile app in their classroom. 

http://mimio.com/QuickLearn
http://mimio.com/QuickLearn
http://mimioconnect.com/
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Q: In these lesson samples, are students using the Mimio stylus or mobile devices to interact? 
A: Depending on your instructional goals, both methods could be used. You could have students come 
to the front of the room and interact with lesson elements on the screen. You could then also switch it 
up and either give individual students control to complete activities on individual mobile devices or push 
the lesson out to all mobile devices in a collaborative activity. Using the MimioMobile app, you have 
many options to utilize. 

Q: How do I show the students working on the screen? Is there a maximum number that can be 
shown? 
A: When using the Collaborate mode with MimioMobile enabled mobile devices, each individual 
student’s mobile device will show on the front-of-room display. You can have up to 50 students 
collaborating at the same time. With the new features available in the MimioMobile app, you can 
choose to hide the screen at the front of the room, pause activity, and select any number of student 
mobile devices to be shown on the screen. Find out more in our Mimio Goes Mobile Quick Learn session 
or from our MimioMobile Toolbar Reference card. 

Q: How can I learn the basics of using Mimio hardware and the tools in the software? I want to learn 
how to get the most from our interactive whiteboard. 
A: We have a number of training options to help you get started. From our free Quick Learn training 
sessions to our over 60 short video tutorials, we provide the resources to help you get up to speed 
quickly. Check out our training offerings at http://mimio.com/en‐NA/Training/Overview.aspx. We also 
offer our fall and spring webinars, which are presented by expert teachers who use MimioClassroom™ 
products in their own classrooms. Find our upcoming schedule of webinars or on-demand recordings at 
http://mimio.com/webinar. Another great resource is our MimioConnect® online teacher community. 
On mimioconnect.com, you’ll find thousands of ready-to-use lessons and ideas from educators who use 
Mimio products. You can search for lessons based upon subject, grade level, or keyword criteria. Many 
lessons are aligned with Common Core and State Standards. Start exploring at 
http://mimioconnect.com. 
 
Q: I have MimioStudio Notebook. I keep hearing about the MimioTeach. How are they different? 
A: Great questions! MimioStudio Notebook is the actual software that runs on your computer. Using the 
software, you can open and create your own interactive lessons to use in your classroom. You can also 
open any already prepared lesson files from other teachers or from our teacher community, 
MimioConnect. The MimioTeach™ interactive whiteboard is our flagship portable interactive 
whiteboard product. It’s an interactive bar that magnetically attaches to any existing whiteboard or flat 
surface you have in your classroom. Using the MimioTeach along with the MimioStudio software, you 
instantly transform your regular whiteboard into an interactive teaching tool. Find out more about the 
MimioTeach and all of our other MimioClassroom products here. 
 
Q: How do I become a member of MimioConnect? 
A: It’s easy! Visit MimioConnect and click on “Click Here to Register” under the Why Become a Member 
section on the right. Enter some brief information about yourself, select a username and password, and 
you are set to explore all the wonders of MimioConnect. Learn more about how to maximize the 
resources of MimioConnect in our On-Demand Quick Learn recording. 

 

http://mimio.com/QuickLearn
http://www.mimio.com/~/media/Files/Downloads/Support/Documentation/MimioMobile/MimioMobileToolbars_MS11.ashx
http://mimio.com/en‐NA/Training/Overview.aspx
http://mimio.com/webinar
http://mimioconnect.com/
http://mimioconnect.com/
http://www.mimio.com/en-NA/Products/MimioClassroom-Family-of-Products.aspx
http://www.mimioconnect.com/
http://www.mimioconnect.com/user/register
https://mimio.adobeconnect.com/p90qk5he6qz/
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Q: How do I start to create lessons like the ones shown? 
A: The goal is to try to think interactively when using existing lessons or developing your own. Start with 
a concept you want to teach. You might take a textbook concept and think about how to make it 
interactive for your students. Start simply with the concept itself, and add text and graphic components. 
Build in interactivity by adding pull-outs, sorting activities, reveals from the Gallery, and animations. 
Beginning like this will help the lesson continue to develop. Remember that you don’t have to start from 
scratch. Use the “insert file” ability of MimioStudio software to insert your existing Word, PDF, and 
PowerPoint files right into the software, and then add a few elements to make them interactive. Learn 
more about how to do this in our “MimioStudio: Adding Content” Quick Learn session. 

Learning the tools and how to use them in MimioStudio software will make the process easier. Take 
advantage of the free training resources, including short video tutorials and Quick Learn sessions, which 
can be found at http://www.mimio.com/en-NA/Training/Overview.aspx. 

Note: Because we regularly receive many questions on how to develop this type of lesson, we have a 
MimioTraining Quick Learn session, “MimioStudio: Putting Instructional Design to Work.” Register at 
http://mimio.com/QuickLearn. 

Q: Can you use the MimioMobile app on laptop computers? 
A: Although you can install and run MimioStudio software on student laptops for them to use, the 
MimioMobile app is designed only for mobile devices. Only a teacher laptop running MimioStudio 
software and the licensed MimioMobile features will be able to interact with student mobile devices 
that have the MimioMobile app. Student laptops will not be able to use the Collaborate features as they 
would on a mobile device, since this is not how the app was designed or intended to be used. In order to 
use the MimioMobile license, the teacher’s computer must have MimioStudio software installed. In 
addition, student mobile devices and a teacher mobile device have to be enabled with the free 
MimioMobile app to be able to interact throughout the classroom. 

Q: We have a computer lab for students to use. Can I have students use lessons on the computers? 
A: The MimioStudio software can be used on Mac, PC, and Linux computers, and you can install the 
software on any computer you or your students use. They can use the free limited version to create, 
open, and manipulate MimioStudio lesson files. 

Q: Can I add an mp4 or other documents (Word, PDF, etc) to MimioStudio and then use the tools that 
are available.  
A: This is one of the most valuable features of the MimioStudio software that allows you to use your 
existing lesson resources without reinventing. You can insert Word documents, PDFs, PowerPoint files, 
images, audio, videos, Flash files, and other interactive whiteboard files. Simple click on the Insert > File 
button in the top menu. Browse to the resource located on your computer. The file will be inserted into 
the MimioStudio software giving you the power to use any of the MimioStudio tools as well as add you 
own interactive elements to the lesson. You may need third-party codec files installed on your computer 
in order for certain files to be utilized. Download Windows and Mac video codec packs. As an 
alternative, you can also hyperlink to any file resource you have on your computer from MimioStudio 
software. The benefit of this is that the file will open in the native program that your computer typically 
uses. Learn more about formatting objects and adding hyperlinks. Find out more in our On-Demand 
Video Tutorials under the “Adding Content” section. 

http://www.mimio.com/en-NA/Training/Overview.aspx
http://mimio.com/QuickLearn
http://download.cnet.com/K-Lite-Mega-Codec-Pack/3000-13632_4-10794603.html
http://multimedia.software.informer.com/download-multimedia-player-mac-codec/
http://www.mimio.com/en-NA/Training/On-Demand-Video-Tutorials.aspx
http://www.mimio.com/en-NA/Training/On-Demand-Video-Tutorials.aspx
http://www.mimio.com/en-NA/Training/On-Demand-Video-Tutorials.aspx
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Q: How much time did it take our presenters to remake these lessons? 
A: Claire and Lindy indicate it took them 2-4 hours. Part of this time involved a little research if it was 
outside their content area. This will obviously vary based upon your experience level with the 
MimioStudio software and your goals you have for a lesson. Starting from scratch, a lesson involving 
slides with interactive activities, assessment options, and other content may involve an hour or less, but 
you want to build multiple activities for students to become engaged. As a beginner, you can expect to 
take more time as you learn formatting techniques and how to achieve your objectives for a lesson. 
Once you have your files set up, future use of these only require tweaking as you save these files 
electronically. There are many ways to start very quick using content you already have such as files from 
Microsoft Word, PowerPoint, and PDFs. These file types including sound, video, and other interactive 
whiteboard files can easily be inserted into the MimioStudio software. This gives you a quick starting 
point to make lesson more interactive using the software. Add to that the number of resources available 
on the MimioConnect community and you’ll find you can get started very quickly without having to 
necessarily reinvent the wheel.  
 
Q: Are certificates available for the on-demand webinars?  
A: Each of our on-demand webinars includes the link for a certificate of completion towards the end of 
the recording. Complete the information by following the link and a certificate can be issued. 
 

Q: Are there options for on-site professional development? 
A: For most professional development that needs to occur on site, we utilize our network of Mimio 
Partners. In some special situations, we can also work with your school directly to provide this type of 
training. In any event, contact training@mimio.com for any requests. 

Q: Does Mimio offer Certified Training or the MimioMasters program still? 
A: We are currently reevaluating our training programs, for now these programs are on hold. We hope 
to have some similar programs available again later in 2015. Contact training@mimio.com for any 
interest in these. 

 
 
 

For Your Information: 

Register for future webinars or watch recordings of previous webinars:  
mimio.com/webinar  

Overview of online and on-demand Mimio training resources:  
mimio.com/en-NA/Training/Overview.aspx  

MimioTraining Quick Learn Training Sessions:  
mimio.com/QuickLearn  

Mimio Webinar Series Certificate of Completion:  
Link is provided in the webinar recording. 

mailto:training@mimio.com
mailto:training@mimio.com
file:///C:/Users/nwitting/AppData/Local/Microsoft/Windows/Temporary%20Internet%20Files/Content.IE5/L9LR8BUQ/mimio.com/webinar
file:///C:/Users/nwitting/Documents/Mimio_doc/mimio.com/en-NA/Training/Overview.aspx
http://mimio.com/QuickLearn

